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Potato starch is a valuable and affordable technical raw 
material for a number of industries. For selection of 
plants producing starch with optimal processing pro
perties effective methods for physicochemical param
eters evaluation of a large number of starch samples 
are needed. Thus, variability of phenotypic traits data 
are important both for fundamental works on identi
fication of genomic loci responsible for a wide range 
of potato starch characteristics as well as for applied 
accelerated selection of new varieties for technical 
use. Estimating the morphology of starch granules by 
microscopy is one of the most accessible and therefore 
widespread methods of phenotyping. We developed a 
fourstep approach to the  estimation of the geometric 
parameters of starch granules. It includes an isolation 
of starch from the tuber (stage 1), the preparation of mi
crographs of starch samples (stage 2), processing and 
analysis of the images obtained in the freely distrib
uted ImageJ program (stage 3), and the construction 
of distribution curve for starch granules by geometric 
parameters (stage 4). It was shown that the starch 
granules of different varieties and hybrids of potato 
differ in morphology and can be differentiated by mi
croscopy with obtaining data on the Feret’s diameter 
and the circularity of the particles. Thus, typical values 
of the Feret’s diameter of starch granules of “Alena” and 
“Nevsky” varieties and 785/85 hybrid are 5, 22 and 
67 microns, respectively. The distributions on circular
ity of starch granules of these varieties and the hybrid 
have only minor differences. Light optical microscopy 
of starch granules followed by digital image analysis 
is an affordable, economical, simple and effective 
approach to phenotyping the varieties and hybrids of 
potato Solanum tuberosum L. on the physicochemical 
parameters of starch. The approach may be applied for 
accelerated analysis of a large number of samples on 
a limited amount of natural material in the field and 
countryside economic laboratories.
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Картофельный крахмал – ценное и доступное техническое сырье 
для целого ряда отраслей промышленности. Для селекции расте
ний, продуцирующих крахмал с оптимальными для переработки 
свойствами, необходимы эффективные методы оценки физико
химических параметров большого количества образцов крахмала. 
Соответственно, данные по изменчивости тех или иных фенотипи
ческих признаков имеют важное значение как для развития фун
даментальных работ по идентификации локусов генома, отвеча
ющих за широкий спектр характеристик крахмала картофеля, так 
и для прикладных работ по ускоренной селекции новых сортов 
технического назначения. Оценка размеров крахмальных гранул 
при помощи микроскопии – один из самых доступных и потому 
распространенных методов фенотипирования. Нами разработан 
состоящий из четырех этапов подход к оценке геометрических 
параметров гранул крахмала: первый этап – выделение  крахмала 
из клубня, второй – получение микрофотографий образцов крах
мала, третий – обработка и анализ полученных изображений в 
свободно распространяемой программе ImageJ, четвертый – по
строение графиков распределения гранул крахмала по геометри
ческим параметрам. Показано, что гранулы крахмала различных 
сортов и гибридов картофеля различаются по морфологии и могут 
быть дифференцированы методом микроскопии с получением 
данных о диаметре Фере и округлости частиц. Так, моды диаметра 
Фере гранул крахмала сортов Алена, Невский и гибрида 785/85 
составляют 5, 22 и 67 микрон соответственно. В распределении 
гранул крахмалов этих сортов и гибрида по округлости наблюда
ются лишь незначительные отличия. Микрофотографирование 
гранул крахмала с последующей обработкой изображений пред
ставляет собой доступный, экономичный, простой и эффективный 
подход к фенотипированию сортов и гибридов картофеля Solanum 
tuberosum L. по физикохимическим парамет рам крахмала. Этот 
метод может применяться для ускоренного анализа большого чис
ла образцов на ограниченном количестве природного материала, 
в том числе в полевых и хозяйственных лабораториях.

Ключевые слова: крахмал; морфология; микроскопирование; 
диаметр Фере; округлость.
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Картофельный крахмал, нативный или переработан
ный, – ценное и доступное техническое сырье для 
пи щевой, целлюлознобумажной, текстильной, хими

ческой, строительной и ряда других отраслей промыш
ленности. Для эффективной реализации потенциала 
картофельного крахмала необходима работа по селекции, 
инвентаризации и тестированию особых сортов картофеля 
Solanum tuberosum L., способных выступить продуцента
ми подходящего по физикохимическим свойствам техни
ческого крахмала, а также дальнейшей его переработке в 
продукты с высокой добавленной стоимостью.

На данный момент в мире селекционная и семено
водческая работа переходит на новый технологический 
уровень. При этом в оценке множества сортов и гибридов 
картофеля центральную роль играют высокоэффективные 
поточные методы фенотипирования с низкой себестоимо
стью, способные дать надежную информацию о полезных 
признаках растения используя ограниченное количество 
материала и доступное для удаленных и полевых локаций 
оборудование. Так, экологогеографические испытания 
сортов картофеля, проводимые в 2016–2017 гг. в России, 
подразумевают в том числе и анализ свойств крахмала, 
полученного из шестидесяти сортов картофеля, выращен
ных в пяти различных географических локациях.

Несмотря на то что гены, которые кодируют основные 
ферменты, участвующие в биосинтезе и метаболизме 
крахмала, в настоящее время выделены и охарактери
зованы (Хлесткин и др., 2017), остается неясной роль 
конкретных структурных генов (а возможно, и участие 
еще не выявленных регуляторных генов) в формировании 
тех или иных характеристик крахмала. Поэтому данные по 
изменчивости фенотипических признаков имеют важное 
значение как для развития фундаментальных работ по 
идентификации локусов генома, отвечающих за широ
кий спектр характеристик крахмала картофеля, так и для 
прикладных работ по ускоренной селекции новых сортов 
технического назначения.

Оценка морфологии  
гранул картофельного крахмала
Гранула картофельного крахмала представляет собой об
разование размером примерно 5–100 мкм, как правило, 
овальной формы. Гранула состоит из кристаллических 
слоев, образованных за счет особой упаковки концевых 
линейных полисахаридных цепей амилопектина, и из 
аморфных слоев, образованных амилозой и фрагментами, 
в которых происходит разветвление цепей амилопектина.

В биосинтезе крахмала в клубнях картофеля принимают 
участие около двадцати ферментов. Около десяти из них 
действуют непосредственно внутри или на поверхности 
крахмальной гранулы, находящейся в пластиде, поэтому 
морфология крахмальной гранулы связана с активностью 
некоторых генов биосинтеза крахмала, а также, возможно, 
с рядом регуляторных участков генома. Таким образом, 
задача высокопроизводительного фенотипирования сор
тов и гибридов картофеля по морфологическим признакам 
крахмальных гранул является актуальной с точки зрения 
применения современных методов геномной и/или мар
керориентированной селекции для направленного созда
ния сортов с заданными свойствами крахмала.

Оценка размеров крахмальных гранул при помощи 
микроскопии – один из самых доступных и потому рас
пространенных методов фенотипирования. Однако в 
большинстве случаев исследователи ограничиваются 
качественным описанием формы гранул, иногда проводят 
наблюдение оптических свойств гранул – окраски после 
обработки раствором йода либо двулучепреломления в 
поляризованном свете (Karlsson et al., 2007), без стати
стического анализа полученных изображений (Blennow 
et al., 2003). Заметим, что в отличие от более сложных 
и дорогих подходов (Wilson et al., 2006; Romano et al., 
2016), с помощью микроскопии можно провести анализ 
размеров большой выборки гранул за ограниченное время 
(Li et al., 2011).

Размер гранул важен для ряда технических и пищевых 
применений картофельного крахмала: если в пищевой 
индустрии ценятся сорта с крупными гранулами крахмала, 
то многие технические решения требуют сортов, содер
жащих мелкие гранулы (de Vetten, 2004). При этом наряду 
с диаметром или площадью гранулы необходимо сразу 
получать информацию, так или иначе характеризующую 
ее форму. Частицы, имеющие одинаковый наибольший 
диаметр, могут значительно различаться по форме – от 
идеально круглых до вытянутых или волокнообразных, 
поэтому нужны дополнительные данные, дающие пред
ставление об их форме.

Отметим, что в силу своей доступности, экономичности 
и объективности в области фенотипирования растений 
активно развиваются методы, связанные с цифровым 
анализом изображений (см., например, (Si et al., 2017)). 
В ходе работы по фенотипированию сортов и гибридов 
картофеля по физикохимическим признакам крахмала 
нами разработан подход, позволяющий быстро оценить не 
только размер гранул, но и их округлость, которая также 
является важным техническим параметром. В целом для 
автоматического цифрового анализа микрофотографий 
доступны более 30 морфологических характеристик. 
Кроме диаметра и округлости гранул, автоматически 
может оцениваться площадь изображения гранул, пло
щадь выпуклой оболочки, периметр, отношение пло
щади к периметру, количество включений, координаты 
центра масс, удлинение, извилистость и другие характе 
ристики.

Первый этап. Выделение крахмала  
из клубней разных сортов и гибридов картофеля
Картофельный крахмал из клубней сортов и гибридов 
картофеля из коллекции «ГенАгро» ФИЦ ИЦиГ СО РАН 
выделяли стандартным методом, основанным на гравита
ционном осаждении гранул крахмала в воде (см., напри
мер, (Chung et al., 2014)).

Второй этап. Получение микрофотографий  
гранул крахмала
Основные задачи на этом этапе – получить корректное 
фотографическое изображение гранул крахмала, пригод
ное для дальнейшей цифровой обработки. Необходимо 
избегать как скученности гранул крахмала с образованием 
кластеров, так и излишней разреженности изображений, 
которая может существенно уменьшить выборку измеря
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емых объектов. Желательно обеспечить также хо рошую 
контрастность изображения. Наиболее простой и удобной 
для оператора формой образца является дисперсия крах
мальных гранул в жидкой среде, помещенная между стан
дартными предметным и покровным стеклами. Хорошая 
смачиваемость гранул крахмала водой и их относительно 
невысокая плотность (1.54 г/см3) (Isleib, 1958) позволяют 
использовать воду в качестве среды и отказаться от при
менения диспергирующих агентов и регуляторов вязкости. 
Водная суспензия гранул с концентрацией 0.5 % и объ
емом 20 мкл, нанесенная на предметное стекло, обеспе
чивает удобную для последующей обработки плотность 
расположения гранул в освещенном поле: так, чтобы они 
не перекрывали друг друга.

Для получения репрезентативной выборки проводилось 
фотографирование не менее четырех различных участков 
светового поля, чтобы в сумме получить изображение 
1 500–2 500 частиц. При этом неплохие результаты дает 
съемка в проходящем свете методом светлого поля: все 
гранулы видны, имеют четкие границы, хорошо выра жен
ную морфологию. При увеличении более чем в 200 раз 
различается структура гранул с концентрическими че
редующимися слоями разной кристалличности вокруг 
единого центра формирования слоев (рис. 1, а). Можно 
также увидеть и оценить наличие аномальных гранул, в 
которых произошло нарушение слоистой структуры в ходе 
их образования (рис. 1, б ).

В случаях, когда микроскопирование гранул крахмала 
проводится не для изучения деталей их строения, а для 
оценки их морфологии, рекомендуется получить как 
можно более контрастное изображение, используя, напри
мер, раствор йода (можно взять аптечный раствор йода, 
разбавленный смесью спирта и воды (1 : 1) в 200 раз). 
У сортов с обычным содержанием амилозы (~20–30 %) 
гранулы приобретают темносинюю окраску, фотографии 
становятся более контрастными, позволяя достоверно 
оценить количество, форму и размер гранул. При этом не 
окрашиваются и не учитываются при подсчете и анализе 

органические примеси некрахмальной природы, случайно 
попавшие в образец при обработке.

Третий этап. Обработка микрофотографий  
гранул крахмала в программе ImageJ
Полученные микрофотографии крахмала удобно обраба
тывать в программе ImageJ (ImageJ, 2017). В приложении 
имеется набор стандартных инструментов, позволяющий 
изменять контрастность изображений, резкость, сглажи
вание, обнаруживать границы и выполнять другие повсе
дневные задачи.

Сначала проводится калибровка программы, напри
мер по шкале, сфотографированной в микроскоп через 
тот же объектив, что и исследуемые образцы (операции 
«Установить шкалу» (Analyze → Set scale)). Далее мож
но работать с микрофотографиями гранул крахмала, как 
с неокрашенными йодом, так и с окрашенными. Для 
сравнения приведен результат обработки фотографии 
неокрашенных гранул крахмала в программе ImageJ при 
помощи последовательности операций «Заполнение обла
стей» (Process → Binary → Fill holes) (рис. 2) и фотография 
окрашенных гранул крахмала того же сорта без обработки 
(рис. 3). Видно, что при обработке фотографии неокра
шенных гранул некоторые из них не были распознаны как 
замкнутый объект и, соответственно, будут некорректно 
учтены программой при подсчете и измерении. Заметим, 
что большая часть гранул была некорректно  распознана 
изза того, что они не полностью попали в область фото
графирования и находятся у края изображения. При ав то
матическом распознавании можно не принимать во вни
мание эти краевые гранулы (в ImageJ предусмотрена такая 
возможность). Далее мы будем описывать работу только 
с окрашенными образцами крахмала.

Для проведения подсчета и анализа формы гранул про
ще работать с 8битным изображением (Image → Type → 
8 bit). Установим пределы распознавания (Image → 
Adjust → Threshold…) и воспользуемся командой «Приме
нить» (Apply). На полученном изображении видно, какие 

50 мкм100 мкм

Рис. 1. Фотография гранул картофельного крахмала, сорт Алена.

а – увел. в 252 раза; б – увел. в 630 раз. Стрелками показаны аномальные гранулы с нарушенной структурой концентрических слоев.

а б
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именно частицы будут распознаны для подсчета и анализа. 
Если границы распознавания выставлены правильно, 
будут подсчитаны только гранулы крахмала, но не при
месные частицы с другими цветовыми характеристиками.

Как видно, две или несколько гранул могут соприка
саться так, что их изображение распознается как единое 
поле. Для разделения таких полей на отдельные частицы 
воспользуемся опцией «Водораздел» (Process → Binary → 
Watershed), которая создает разделительные линии тол
щиной 1 пиксель между предполагаемыми отдельными 
частицами.

Теперь зададим параметр для измерения (Analyze → Set 
measurements…), отметив соответствующие характери
стики. В нашем случае были выбраны «Площадь» (Area), 
«Характеристики формы» (Shape descriptors), «Диаметр 
Фере» (Feret’s diameter).

Запуск процесса измерения осуществляется опцией 
«Анализировать частицы…» (Analyze → Analyze par
ticles…). В меню надо указать предельные величины 
площади учитываемых силуэтов на изображении (мы 
устанавливали величины от 5 мкм2 до бесконечности). 
Для этого поставим «галочку» напротив «Показывать ре
зультаты» (Display results), чтобы результаты появились на 
экране в виде таблицы, и напротив «Исключить краевые» 
(Exclude on edges), чтобы не учитывать частично видимые 
гранулы по краям изображения. После этого нажатием 
кнопки «ОK» получаем таблицу с результатами измерений 
в окне «Результаты» (Results).

Четвертый этап. Минимальная статистическая 
обработка полученных данных
Программа ImageJ предоставляет некоторые возможно
сти по статистической обработке данных. Так, прямо в 
окне «Результаты» (Results) в меню «Распределение…» 
(Results → Distribution…) можно задать требуемые пара
метры и получить результат в графическом виде.

В нашем случае данные, полученные при анализе не
скольких изображений для каждого образца, были ско

пированы в файл Excel и обработаны с помощью пакета 
«Анализ данных». Для анализа можно использовать лю
бую предназначенную для этого программу, но поскольку 
этот протокол рассчитан для работы в любых, в том числе 
полевых и слабооснащенных лабораториях, имеет смысл 
пользоваться наиболее распространенным и знакомым 
программным продуктом, нередко установленным на 
компьютере «по умолчанию».

В качестве примера были взяты образцы крахмала 
сор тов Алена, Невский и гибрида 785/85. Здесь и далее 
для каждого образца проанализированы четыре микро
фотографии с разных его участков на предметном стекле 
(250–350 гранул в каждом изображении). Полученные 
кривые распределения по максимальным диаметрам Фере 
показаны на рис. 4. Диаметр Фере – это расстояние между 
касательными к контуру изображения, проведенными па
раллельно направлению просмотра. В нашем случае для 
каждой гранулы автоматически выбиралась максимальная 
величина диаметра Фере и их совокупность представля
лась в виде кривой, характерной для рассматриваемого 
образца крахмала. Видно, что крахмалы сорта Невский и 
гибрида 785/85 имеют преимущественно мономодальное 
распределение максимальных диаметров Фере с модами 
22 и 67 мкм соответственно. Гранулы крахмала сорта 
Алена распределены более равномерно, от 3 до 85 мкм, 
со значительным содержанием мелкой фракции и модой 
5 мкм. Средние величины максимальных диаметров Фере 
указаны в таблице.

Округлость гранул оценивалась по формуле

Округлость = 4π × Площадь изображения гранулы
(Периметр изображения гранулы)2  .

Значение округлости, равное 0, формально соответствует 
бесконечно вытянутому многоугольнику, значение, рав
ное 1, соответствует идеальному кругу. 

По графику округлости гранул (рис. 5) можно отметить, 
что крахмал сорта Алена имеет немногим более высокую 
моду округлости и более узкое распределение. Гранулы 

Рис. 3. Фотография окрашенных раствором йода гранул картофель
ного крахмала, сорт Алена. Увел. в 63 раза.

Рис. 2. Гранулы картофельного крахмала, сорт Алена. Увел. в 63 раза.
Применена операция «Заполнение областей» (Process → Binary → Fill holes) 
в программе ImageJ. Стрелками показаны некоторые неверно распознан
ные гранулы.

100 мкм 100 мкм
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Рис. 4. Распределение по максимальным диаметрам Фере гранул крахмала сортов Алена, 
Нев ский и гибрида 785/85.

Средние величины максимальных диаметров Фере и округлости  
и стандартные отклонения

Сорт, гибрид Среднее значение

максимального диаметра Фере, мкм округлости

Алена 37.58 ± 20.09* 0.78 ± 0.15

Невский 25.64 ± 21.69 0.85 ± 0.08

785/85 52.21 ± 14.68 0.85 ± 0.04

* Рядом со средним значением указано стандартное отклонение.
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Рис. 5. Распределение по округлости гранул крахмала сортов Алена, Невский и гибрида 785/85.

крахмала сорта Невский и гибрида 785/85 менее округлые и отличаются 
несколько большим содержанием фракций 0.75–0.82. Средние величины 
округлости гранул крахмала приведены в таблице.

Описанный метод фенотипирования сортов и гибридов картофеля по микро
фотографическим изображениям крахмала в сочетании со статистической 
обработкой будет в числе других использован при исследовании коллекции 
картофеля «ГенАгро» ФИЦ ИЦиГ СО РАН для выявления контрастных 
форм и связи с соответствующими генными сетями биосинтеза крахмала для 
дальнейшего применения в маркерориентированной селекции картофеля на 
полезные технологические признаки.

Протокол выделения крахмала 
из клубней картофеля

1. Отобрать дватри характерных 
для данного сорта или гибрида 
клубня картофеля без поврежде
ний (средний вес одного клубня 
составляет примерно 90 г).

2. Клубни отмыть от земли, высу
шить после мытья, взве сить.

3. Измельчить на механической тер
ке или соковыжималке, дважды 
пропустив биомассу клубня через 
устройство.

4. Отфильтровать полученную мас
су через тканевый фильтр (диа
метр отверстий не менее 250 мкм),  
отжать.

5. Отфильтрованную массу, остав
шуюся на ткани, перенести в 
мерный стакан с дистиллирован
ной водой. Соотношение массы к 
объему воды примерно 1 : 2.

6. Взболтать несколько раз в тече
ние 15 мин, отфильтровать полу
ченную взвесь через тканевый 
фильтр (диаметр отверстий не 
менее 250 мкм), отжать.

7. Отфильтрованную массу, остав
шуюся на ткани, опять поместить 
в мерный стакан с таким же коли
чеством воды.

8. Взболтать несколько раз в тече
ние 15 мин, отфильтровать полу
ченную взвесь через тканевый 
фильтр (диаметр отверстий не 
менее 250 мкм), отжать.

9. Оставшуюся на фильтре мезгу 
высушить при комнатной темпе
ратуре, взвесить.

10. Фильтрат оставить в покое при 
комнатной температуре на 90 мин,  
при этом происходит осаждение 
крахмала.

11. Декантировать жидкость, остав
ляя крахмал на дне.

12. Добавить к крахмалу ~300 мл во
ды, взболтать, оставить на 90 мин.

13. Декантировать жидкость, остав
ляя крахмал на дне.

14. Добавить к крахмалу 200 мл во
ды, взболтать, оставить на 90 мин.

15. Декантировать жидкость.
16. Влажный крахмал перенести на 

чашку Петри, высушить при ком
натной температуре, периодиче
ски перемешивая.

17. Взвесить высушенный крахмал, 
определить препаративный вы
ход (типичный выход – 10–20 % 
от массы исходного картофеля).
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Практическое руководство по оценке морфологии гранул 
картофельного крахмала методом микроскопирования

Протокол оценки морфологии  
гранул картофельного крахмала  
методом микроскопирования (рис. 6)

1. Шпателем измельчить 5 мг крахмала, поместить в 
пробирку и добавить 1 мл дистиллированной воды.

2. К полученной смеси добавить 50 мкл раствора йода в 
водноспиртовой смеси (можно использовать разбав
ленный в 200 раз смесью воды и спирта (1:1) аптечный 
раствор йода). Встряхнуть на шейкере.

3. Пипетированием взболтать содержимое пробирки до 
состояния суспензии и отсутствия осадка окрашен
ного крахмала на дне, нанести 20 мкл суспензии на 
предметное стекло и накрыть.

4. Получить не менее четырех микрофотографий с раз
ных участков образца крахмала (250–350 гранул в 
каждом изображении).

5. Откалибровать ImageJ для работы с изображениями 
в микрометрах.

6. Открыть изображение гранул крахмала.
7. Выполнить преобразование в 8битный рисунок 

(Image → Type → 8 bit).
8. Установить «Пределы распознавания…» (Image → 

Adjust → Threshold…), нажать «Применить» (Apply).
9. Разделить соприкасающиеся частицы «Водораздел» 

(Process → Binary → Watershed).
10. Выбрать измеряемые параметры (Analyze → Set mea

surements…).
11. Провести измерение (Analyze → Analyze particles…).
12. Скопировать или сохранить результаты измерений из 

получившейся таблицы в формате, читаемом програм
мой для последующей обработки, например Excel.

13. Повторить шаги 6–12 для остальных изображений 
этого же образца.

14. При необходимости организовать данные в графиче
ском виде.

Необходимые материалы и оборудование
1. Вода дистиллированная и набор лабораторной посуды 

для выделения крахмала.
2. Микроскоп с возможностью получения фотографиче

ских изображений гранул крахмала. В данной работе 
проводилась съемка в проходящем свете методом свет
лого поля. Использовался прямой исследовательский 
микроскоп Axio Scope A1 (Carl ZEISS), объектив – 

APlan 10x/0.25, CCD камера – AxioCam ICc 3, Адаптор – 
TV 2/3′′C 0.63x, программное обеспечение ZEN, общее 
увеличение 10 (объектив) ×10 (окуляр) × 0.63 (адаптор).

3. Программа ImageJ для подсчета и измерения гранул 
крахмала.

Заключение
Гранулы картофельного крахмала различных сортов 
и гибридов различаются по морфологии и могут быть 
исследованы методом микроскопии. Так, типичные ве
личины диаметра Фере гранул крахмала сортов Алена, 
Невский и гибрида 785/85 составляют 5, 22 и 67 мкм со
ответственно. Микрофотографирование гранул крахмала с 
последующей обработкой микрофотографий представляет 
собой доступный, экономичный, простой и эффективный 
подход к фенотипированию сортов и гибридов картофеля 
Solanum tuberosum L. по физикохимическим параметрам 
крахмала, который может применяться для ускоренного 
анализа большого числа образцов на ограниченном коли
честве природного материала, в том числе в полевых и 
хозяйственных лабораториях.

Благодарности
Pазработка стандартной операционной процедуры по 
оценке морфологии гранул крахмала выполнена в рамках 
дополнительной темы государственного задания ИЦиГ 
СО РАН по биоресурсным коллекциям № 032420170001. 
Микрофотографирование, цифровая обработка и анализ 
препаратов крахмала выполнены при финансовой под
держке РФФИНСО (проект № 1744540510). Образцы 
картофеля получены из коллекции ЦКП «ГенАгро» ИЦиГ 
СО РАН. Авторы выражают благодарность ЦКП микро
скопического анализа биологических объектов СО РАН 
и лично Т.Е. Алешиной за помощь в получении микро
фотографий образцов крахмала.

Конфликт интересов
Авторы заявляют об отсутствии конфликта интересов.

Список литературы
Хлесткин В.К., Пельтек С.Е., Колчанов Н.А. Генымишени для 

получения сортов картофеля (Solanum tuberosum L.) с заданны
ми свойствами крахмала. С.х. биология. 2017;52(1):2536. DOI 
10.15389/agrobiology.2017.1.25rus. 

Рис. 6. Блоксхема обработки изображения по протоколу оценки морфологии гранул картофельного крахмала методом 
микроскопирования (шаги 6–14).

Калибровать  
ImageJ

Провести  
статистическую 

обработку

Открыть  
изображение

Преобразовать 
в рисунок  

8 бит

Установить 
пределы  

распознавания

Сохранить  
данные

Провести  
измерения

Выбрать  
измеряемые 
параметры

Разделить  
соприкасающиеся 

объекты



A practical guide to the starch granules’ 
morphology study by microscopy

V.K. Khlestkin 
T.V. Erst

734 Molecular genetics and cell biologyVavilov Journal of Genetics and Breeding • 2017 • 21 • 6

Blennow A., Hansen M., Schulz A., Jurgensen K., Donald A.M., San
derson J. The molecular deposition of transgenically modified starch 
in the starch granule as imaged by functional microscopy. J. Struct. 
Biology. 2003;143:229241. DOI 10.1016/j.jsb.2003.08.009.

Chung H.J., Li X.Q., Kalinga D., Lim S.T., Yada R., Liu Q. Physico
chemical properties of dry matter and isolated starch from potatoes 
grown in different locations in Canada. Food Res. Int. 2014;57:89
94. DOI 10.1016/j.foodres.2014.01.034.

ImageJ. An open platform for scientific image analysis. http://imagej.
net/Welcome. (дата обращения 24.07.2017). 

Isleib D.R. Density of potato starch. Am. Potato J. 1958;35(3):428429. 
DOI 10.1007/BF02851300.

Karlsson M.E., Leeman A.M., Björck I.M.E., Eliasson A.C. Some 
physical and nutritional characteristics of genetically modified pota
toes varying in amylose/amylopectin ratios. Food Chem. 2007;100: 
136146. DOI 10.1016/j.foodchem.2005.09.032.

Li X.Q., Zhang J., Luo S., Liu G., Murphy A., Leclerc Y., Xing T. Ef
fects of sampling methods on starch granule size measurement of 
potato tubers under a light microscope. Int. J. Plant Biol. 2011;2(e5): 
1418. DOI 10.4081/pb.2011.e5.

Romano A., Mackie A., Farina F., Aponte M., Sarghini F., Masi P. Char
acterization, in vitro digestibility and expected glycemic index of 
commercial starches as uncooked ingredients. J. Food Sci. Technol. 
2016;53(12):41264134. DOI 10.1007/s1319701623759.

Si Y., Sankaran S., Knowles R., Pavek M.J. Potato tuber lengthwidth 
ratio assessment using image analysis. Am. J. Potato Res. 2017; 
94(1):8893. DOI 10.1007/s1223001695451.

de Vetten N.C.M.H. Method for modifying the size and/or morphology 
of starch granules. Pat. EP1473307A1, 2004.

Wilson J.D., Bechtel D.B., Todd T.C., Seib P.A. Measurement of wheat 
starch granule size distribution using image analysis and laser dif
fraction technology. Cereal Chemistry. 2006;83(3):259268. DOI 
10.1094/CC830259.


